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Section 1  

About this document 

This document contains information about the software AMA.remote. 

1.1 Revisions 

V00.01 November 2010 
First release 
 
V00.02 January 2011 
Updated to include monitoring 
 
V00.03 June 2011 
Updated to include long-term measurement data recording 
 
V00.04 December 2013 
Admionistrator mode and user mode added; measuring receiver updated 
 
V00.05 May 2018 
Extension of the Channeltable with D-Channels 
Extension of the Tuningmemory: Docsis 3.1, Inputsource (Coax, Fibre), Unicable extenstion to 5 
Wideband LO’s and 8 banks, Jess support 

1.2 Reference documents 

This manual refers to the following documents: 

• AMA310 Antenna Measuring Receiver Operating Manual 

• AN001 SNMP Remote Control Application Note 

1.3 Contacting the manufacturer 

For current information about products from KWS-Electronic, visit our website at www.kws-
electronic.de. All contact details can also be found there. 
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Section 2  

General 

2.1 License terms 

The following license terms apply for AMA.remote. 
 
This software includes software from other producers: 

• Dart Communications (http://www.dart.com) 

• Lu Yixiang (http://www.lyxite.com/) 

• Matteo D’Avena (http://www.merchandisingplaza.com) 

• mav.northwind (http://www.4voice.de) 

• Shine Kumar (http://www.codeproject.com/Members/Shine-Kumar) 
 
The related license provisions for these software products can be viewed on the Internet or 
requested from the manufacturer. The purchase of this software obligates you to accept these 
provisions. If you do not accept these provisions, immediately return the unused product to the 
supplier. 
 
AMA.remote is protected by Directive 2001/29/EC and other copyright laws. 
 
If you have acquired this software on a data medium and do not agree to the provisions mentioned 
above, return this software. 
 
If you have received this software in electronic form (via the Internet, for example), the following 
provisions apply:  
 
You must completely delete all components received.  
 
The grantor of the licence has the right to personally ensure the complete deletion of the program 
components etc. on site at the customer’s location.  
 
Upon request from the grantor of the licence, the licence holder is also obligated to submit an 
affidavit that the program components have been completely deleted. 
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Section 3  

Installation 

3.1 Preparation 

3.1.1 System requirements 

Verify that your PC meets the following requirements: 

• Random Access Memory (RAM) of at least 512 MB 

• Free hard drive space of at least 1 GB 

• Network connection (LAN, WLAN, ...) if applicable  

• Windows operating system Windows XP, Windows Vista, Windows 7 or Windows 8 

3.1.2 Installation file 

When you download AMA.remote or install it from the CD onto your hard drive, you receive the file 
Setup.msi for installation of the AMA.remote software. 

3.2 Installation of AMA.remote 

Double-click file Setup.msi to start the installation assistant for installation of the AMA.remote 
software on your PC. Follow the instructions and end the installation with “Close”. 
 
A link to the program is automatically created on the desktop and in the Quick Start Toolbar. 

3.3 Further installation information 

3.3.1 Files in the program directory 

Program file AMAremote.exe, several library files and the operating manual are located in the 
program directory (C:\Program Files\AMAremote, for example). 

3.3.2 Files in the application directory 

The application directory ..\AMA.remote\<Version number>\ contains both the initialization file 
“amaremote.ini” and the file “user.xml”, which contains information about the valid user. 
Furthermore, this is the standard directory for saving the monitoring log file (see section “The 
monitoring application area”). 

3.3.3 Uninstallation 

The AMA.remote software can be completely deleted from the PC using the Quick Launch Toolbar  
by choosing Control Panel -> Software -> Remove AMAremote. 
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Section 4  

Introduction to AMA.remote 

4.1 Start program 

You have the option to log in to AMA.remote either as an administrator or as a user. In administrator 
mode, you can add measuring devices to the list of SNMP agents, make changes to the 
administrator login data and manage user accounts. In user mode, you can only access measuring 
receivers through IP addresses that have already been created. You don’t need to have any 
knowledge of network conditions in this mode. 
 

 
 
If you don’t need different access authorizations and thereby don’t need different login modes, you 
can keep the standard settings for the login name and password. You can find more information 
about the administrator and user settings in the sections “Edit administrator settings” and “Edit user 
settings”. 

4.2 The application areas 

The AMA.remote software can edit files used by the measuring receiver. Under certain conditions, it 
is also possible to operate the measuring receiver remotely. 
 
The files to be edited are tuning memory files (MEM files), channel tables (CHA files) and 
DataLogger files (XML files).  
 
A tuning memory assignment of a measuring receiver is written to a tuning memory file. Every 
memory location can be called up in the measuring instrument, and the instrument tunes itself 
according to the information in the memory location. The tuning memory assignment can be easily 
set or changed by importing a tuning memory file into the measuring receiver. A tuning memory file 
can also be exported from the measuring receiver and saved or imported into another instrument. 
Using AMA.remote, it is possible to import and change existing tuning memory files or to create new 
files. The corresponding tool is called “Tuning memory”.  

 

Channel tables for the various television standards are already stored in the measuring receiver. 
They contain information about the channel spacing, i.e. the channel frequencies and bandwidths. 
For cases in which a system differs from the standard in its channel assignment, it is possible to load 
your own channel table into the measuring instrument by using a CHA file. Such a channel table file 
is created in AMA.remote in the “Channel table” application area. 
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Measurements can be recorded using the DataLogger function of the measuring receiver. The 
measurement data is stored in XML files. AMA.remote can import, display and output these 
DataLogger files. When several DataLogger files are opened at the same time, the contents of the 
files are summarised in a table. The tool for editing DataLogger files is called “Data Log Viewer”. 

 

The “Remote control” tool is used to operate a measuring receiver from a PC using AMA.remote. 
The settings necessary for tuning a measuring receiver can be made here. All measured values and 
parameters that are displayed on the LCD of the measuring receiver are also displayed here. 

 

Similar to the measuring instrument’s monitoring function, AMA.remote allows you to use the 
“Monitoring” tool to monitor a channel or a frequency. First, the measuring receiver is tuned and, 
then, configured for monitoring. If the measured value exceeds a specified limit, a message will 
appear to indicate such. 

 

The “Long-term measurement” data recording tool is available for showing a graphical display and 
recording measured values for up to five channels or frequencies. The desired measurements are 
specified by entering the tuning memory location. The measured values are then retrieved at a given 
interval, displayed in diagrams and stored. 
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4.3 The menu bar 

The menu bar changes depending on the selected tool according to the requirements of the 
respective application area. The menu items “Help”, “Print” and “Exit” will be addressed here, and all 
other menu items will be discussed in detail in the following sections describing the application 
areas. 

4.4 Help 

The submenu item “Info”, with information about the program, is located under the menu item “Help”. 
The window “Info about AMA.remote” contains the current version number of the software, among 
other information, and can be closed with “OK”. 

 

4.5 Print 

4.5.1 Page Setup 

Under “Page Setup”, parameters such as the page format (portrait or landscape format) and the 
width of the margins can be changed. The “Page Setup” window is opened for this. The table view 
within the application is not changed by the settings, but they influence the print output. 
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4.5.2 Print Preview 

The print preview provides information about the number of pages to be printed and how the page 
contents will be displayed. The “Print Preview” window opens. If the printer symbol is clicked in this 
window, a print job is sent to the standard printer without any further confirmation. It is also possible 
to change the zoom level and the number of pages displayed. This allows the effects of a change 
(the column width of a table, for example) to be checked on the printout.  

 

4.5.3 Print 

The submenu item “Print” opens the “Print” window. The desired printer and the number of copies to 
be printed can be set there.  

 

4.6 Status bar 

On the bottom edge on the program window, a status bar is displayed that shows the runtime of the 
program in seconds. Depending on the window selected, the current status of the remote control 
and the currently loaded user channel table are also listed, for example. 

 

4.7 Logo 

Clicking on the logo causes the publisher’s homepage to be called up in the default browser. 

 

If the browser is set so that it always starts on a certain page, it may be necessary to click the logo a 
second time after the browser starts. 

4.8 Exit 

The menu item “Exit” exits the program. 
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Section 5  

The tuning memory application area 

5.1 Display 

If the “Tuning memory” tool is activated, the corresponding application area is displayed in the 
program window. The tuning memory of the measuring receiver contains 200 memory locations. 
Accordingly, a table with 200 rows is displayed. Each row corresponds to a tuning memory location 
and is numbered in the first column.  
 
The cell contents of a row correspond to the information that is contained in a tuning memory 
location. The second column displays whether a memory location is protected (in accordance with 
the display in the measuring receiver). The third column displays whether a memory location is 
empty or the range in which the saved program is located. The content of all other cells of a row 
varies according to the specification in the previous row. 

 

5.2 General procedure 

Clicking a table cell opens a text box or a dropdown menu. Since the information in a cell usually 
has an influence on the cells following it, the entries are made from left to right. If all possible 
settings for a tuning memory location have been made, no more cells can be selected. 
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5.2.1 Tab 

The Tab key can be used to jump from one cell to the next. At the end of a row, the program will 
automatically jump to the next row. 

5.2.2 Erasing a memory location 

The content of a row or a memory location can be deleted by selecting “empty” in the third column. 

5.2.3 Moving row(s) 

Individual rows or several rows can be moved. To do this, the memory location number area of the 
selected area must be left-clicked. 

 

The selected area is then moved to the desired location with the mouse button held down. During 
the process, a line appears that shows the table insertion position that is currently possible. 

 

After the left mouse button is released, the selected area is inserted where the line is located. 

 

5.3 File 

The “File” dropdown menu is located on the far left of the menu bar. 



  Section 5 - The tuning memory application area 

  AMA.remote V00.05 

13 

 

5.3.1 New tuning memory 

Clicking “New” causes the current table to be deleted and a new, empty tuning memory list to be 
displayed. 

5.3.2 Importing a tuning memory file 

The “Import” menu item activates the “Open” window and allows you to import a tuning memory file. 
For example, such a file can be exported from the measuring receiver onto a USB stick and selected 
here. A tuning memory file has the file extension “.mem”, and you confirm the selection of such a file 
by clicking “Open”. The content of the imported tuning memory file is displayed in table form. 

5.3.3 Exporting a tuning memory file 

When exporting the current table into a tuning memory file, the table content is first checked for 
validity automatically (see also the “Checking tuning memory entries” section), and then the “Save 
as” window opens. The save location is selected here and a file name is assigned. You complete the 
process by clicking “Save”. A tuning memory file exported in this way can be imported into the 
measuring receiver using a USB stick.  

5.3.4 Printing a tuning memory file 

See the “Print” section. 

5.4 Edit 

The “Edit” dropdown menu can be activated using the menu bar. “Edit” actions relate to the entire 
tuning memory. 

 

5.4.1 Undo 

The “Undo” action corresponds to the same action in the context menu. 

5.4.2 Redo 

The “Redo” action corresponds to the same action in the context menu. 

5.4.3 Protect whole tuning memory 

This protects the entire tuning memory. Every assigned tuning memory location is marked with an 
asterisk (“*”). Empty memory locations cannot be protected. 

5.4.4 Remove tuning memory protection 

The memory protection of all protected tuning memory locations is removed with this action. 
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5.4.5 Check tuning memory entries 

“Check tuning memory entries” can be used to check whether the information is complete.  
 
If individual entries or several entries are missing, a corresponding message is displayed. The first 
row in which entries are missing is displayed in the message. 

 

As soon as information necessary for successful tuning of the measuring instrument is available for 
all tuning memory locations, a message appears indicating that the information is correct.  

 

5.5 Settings 

Channel tables for the various television standards are stored in the measuring receiver, and this 
corresponds to the standard setting. It is possible to load a user channel table, the use of which is 
taken into considerations when saving a frequency in the tuning memory. In order to create the 
same conditions as on the measuring receiver, the user channel table that is used in the measuring 
receiver can also be loaded into AMA.remote.  

 

The file name of the currently loaded user table appears in the status bar on the bottom edge of the 
AMA.remote window. 

 

During the entry of the settings for a tuning memory location, the selection “standard” appears for 
the stored channel tables, and the selection “user” appears for the currently loaded user channel 
table. 
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5.6 Context menu 

Using the context menu, individual rows or several rows can be edited. An individual row is selected 
by clicking the first or second column. 

 

Several rows can be selected by dragging the cursor while holding down the left mouse button. 

 

You can also select several rows by clicking the first row of the desired area, holding down the shift 
key and then selecting the last row of the desired area. 

 
Right-clicking in the selected area opens the context menu. 

 

5.6.1 Undo 

The “Undo” action resets the table to the previous state. For example, if the information in a row for 
the TV area was mistakenly deleted through a change of the range to SAT, this can be undone. Up 
to five consecutive “Undo” actions are possible. 

5.6.2 Redo 

“Redo” allows an action that was just undone to be redone. Up to five “Redo” actions are possible if 
five actions were previously undone. 

5.6.3 Copy row(s) 

It is possible to copy individual rows or several rows. All selected rows are copied. 
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5.6.4 Paste row(s) 

To paste an individual copied row or several copied rows, right-click the line where the copy should 
be pasted. The existing rows are overwritten in the process. 

 

To avoid inadvertent pasting of rows into the wrong location, a prompt appears that must be 
confirmed with OK if the paste was intentional. 

 

5.6.5 Delete row(s) 

As already mentioned, the content of a row or a memory location can be deleted by selecting 
“empty” in the third column. Another option for deleting a memory range is the “Delete row(s)” action 
in the context menu. This is used primarily for deleting several memory locations at the same time. 
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5.6.6 Protect row(s) 

“Protect row(s)” can be used to protect individual or several tuning memory locations. The 
corresponding row(s) are marked in the second column with an asterisk (“*”). This ensures that a 
memory location can only be changed in the measuring instrument if the memory protection is first 
disabled. If individual or several tuning memory locations are already protected, a checkmark 
appears in the context menu. Clicking on it causes the memory protection in the selected area to be 
disabled. Empty memory locations cannot be protected. 
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Section 6  

The channel table application area 

6.1 Display 

If the “Channel table” tool is activated, the corresponding application area is displayed in the 
program window. The channel table must provide information to the measuring receiver about the 
channel name, the center frequency, the picture carrier frequency and the channel bandwidth for 
every channel. Accordingly, a table with five columns is shown for a row number and this 
information.  
 
The number of rows varies according to the number of channels, but it is not possible to have empty 
rows. The table is also filled from the top to the bottom. It is not possible to edit an additional row 
until the information for a row is complete. 

 

6.2 General procedure 

Clicking a table cell allows a row to be edited. Keyboard entries are ended using the “Enter” or 
“Return” key.  
 
Another option is to fill in the cells from left to right using the Tab key. The information is 
automatically applied when the Tab key is pressed, and the cursor moves to the next cell. 

 

If an entry in the cell for the channel bandwidth is confirmed with the Tab key, the next row is 
automatically filled in, taking into account the information in the current row. 
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The channel number is increased by one, the channel bandwidth is added to the center frequency 
and the picture carrier frequency, and the channel bandwidth can be changed for the following row 
or confirmed with the Tab key.  
 
If the prepopulated content for the cell is often wrong, we recommend that the content of the channel 
bandwidth cell be confirmed with the “Enter” or “Return” key and that the entries for the following row 
be made on a cell-by-cell basis. 

 

6.2.1 Channel name 

The channel name consists of the prefix “C”, “S” or “D” and a number. Other letters, special symbols 
or spaces are not allowed. D channels should use an integer center frequency in MHz of the 
corresponding channel. 

 

Within the channel table, C, S and D channels can alternate in any fashion. Each channel name can 
only be used once. 

6.2.2 Center frequency 

The permitted frequency range for the center frequency corresponds to that of the measuring 
receiver. If no unit is specified, the MHz unit is automatically added. 

 

The center frequency of a channel always needs to be higher than the previous channel. The 
channels are also not allowed to overlap in regard to the channel bandwidth. That means that there 
must be sufficient distance between a given center frequency and the previous center frequency. 

6.2.3 Picture carrier frequency 

The permitted frequency range for the picture carrier frequency corresponds to that of the measuring 
receiver. If no unit is specified, the MHz unit is automatically added. 

 

Like the center frequency, the picture carrier frequency of a channel always needs to be higher than 
the previous channel. The channels are also not allowed to overlap in regard to the channel 
bandwidth. That means that there must be sufficient spacing between a given picture carrier 
frequency and the previous picture carrier frequency. 
 
D channels: The picture carrier frequency corresponds to PLC frequency in Docsis 3.1 systems. In 
other operating modes it has no specific meaning. 
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6.2.4 Channel bandwidth 

You can select 6MHz, 7MHz or 8MHz for the channel bandwidth. At D-channels bandwidth from 
24MHz to 192MHz for Docsis 3.1 systems are also possible.  

 

The difference between the center frequency and the picture carrier frequency must be smaller than 
the channel bandwidth, of course. 

6.2.5 Moving row(s) 

Individual rows or several rows can be moved. To do this, the row number area of the selected area 
must be left-clicked. 

 

The selected area is then moved to the desired location with the mouse button held down. During 
the process, a line appears that shows the table insertion position that is currently possible. 

 

After the left mouse button is released, the selected area is inserted where the line is located. 

 

Note that the frequencies within the channel table must increase from channel to channel. After rows 
have been moved, the frequencies usually must be adjusted accordingly. 

6.3 File 

The “File” dropdown menu is located on the far left of the menu bar. 
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6.3.1 New channel table 

Clicking “New” causes the current table to be deleted and a new, empty channel table to be 
displayed. 
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6.3.2 Importing a user channel table file 

The “Import” menu item activates the “Open” window and allows you to import a user channel table 
file. For example, such a file can be created at an earlier point in time and selected here. A channel 
table file has the file extension “.cha”, and you confirm the selection of such a file by clicking “Open”. 
The content of the imported channel table file is displayed in table form. 

6.3.3 Exporting a user channel table file 

When exporting the current table into a user channel table file, the table content is first checked for 
validity automatically, and then the “Save as” window opens. The save location is selected here and 
a file name is assigned. You complete the process by clicking “Save”. A channel table file exported 
in this way can be loaded into the measuring receiver using a USB stick. 

6.3.4 Printing a user channel table 

See the “Print” section. 

6.4 Context menu 

Using the context menu, individual rows or several rows can be edited. An individual row is selected 
by clicking the first column. 

 

Several rows can be selected by dragging the mouse while holding down the left mouse button. 

 

You can also select several rows by clicking the first row of the desired area, holding down the shift 
key and then selecting the last row of the desired area. 

 
Right-clicking in the selected area opens the context menu. 

 

6.4.1 Undo 

The “Undo” action resets the table to the previous state. Up to five consecutive “Undo” actions are 
possible. 

6.4.2 Redo 

“Redo” allows an action that was just undone to be redone. Up to five “Redo” actions are possible if 
five actions were previously undone. 
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6.4.3 Copy row(s) 

It is possible to copy individual rows or several rows. All selected rows are copied. 
 

 

6.4.4 Paste row(s) 

To paste an individual copied row or several copied rows, right-click the line where the copy is to be 
pasted. The existing rows are overwritten in the process. 

 

To avoid inadvertent pasting of rows into the wrong location, a prompt appears that must be 
confirmed with OK if the paste was intentional. 

 

Note that each channel name can only be used once. After a copy is made, the channel name must 
be changed as well. Also note that the frequencies within the channel table must increase from 
channel to channel. 

6.4.5 Delete row(s) 

Individual channels or several channels can be deleted by selecting “Delete row(s)” from the context 
menu. If there are any channels that follow, they are automatically moved up within the table.  
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Section 7  

The Data Log Viewer application area 

7.1 Display 

When using the “Data Log Viewer” tool, the corresponding application area is displayed in the 
program window. DataLogger files are created by the measuring receiver using its DataLogger 
function. These are measurement data files with the file extension “.xml”. These files can generally 
be opened and edited with a spreadsheet program that supports editing of XML files. The Data Log 
Viewer in AMA.remote allows easy merging of several files like those that are usually created when 
there are several measurements for a project. 

 

7.2 General procedure 

The Data Log Viewer tool functions only as a viewer. Individual or several DataLogger files can be 
displayed in a table but cannot be edited. It is possible to export the displayed data into an XML file 
(see the “Exporting a DataLogger file” section) or printing the displayed data (see the “Print” 
section). 
 
As already mentioned, DataLogger files can generally be opened and edited with a spreadsheet 
program that supports the editing of XML files. 
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The display of a DataLogger file with AMA.remote is distinguished by the specification of the file 
names above the measured values. 

 

When several DataLogger files are merged, the name of the respective file appears above the 
corresponding measurement data.  

 

When exporting this table, the program automatically inserts the file names into the XML file above 
the block of measurements. The file names thus also appear when the file is displayed using an 
appropriate spreadsheet program. 
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7.3 File 

The “File” dropdown menu is located on the far left of the menu bar. 

 

7.3.1 Importing a DataLogger file 

The “Import” menu item activates the “Open” window and allows you to import individual or several 
DataLogger files. These files can be saved from the measuring receiver onto a USB stick and 
selected here. A DataLogger file has the file extension “.xml”, and you confirm the selection of the 
corresponding files by clicking “Open”. The content of the imported DataLogger file(s) is displayed in 
table form. 
 
In order to merge several files, several XML files are selected together during import. The files are 
selected here in the “Open” window by pressing the control or switching button and clicking the 
desired file names. As soon as more than one file is selected and “Open” has been activated, the 
files are summarised in a table and can be exported in this form. 

7.3.2 Exporting a DataLogger file 

When exporting the current table into a DataLogger file, the “Save as” window is opened. The save 
location is selected here and a file name is assigned. You complete the process by clicking “Save”. 
A DataLogger file saved in this way can also be opened and edited with a spreadsheet program that 
supports editing of XML files. 

7.3.3 Printing a DataLogger file 

See the “Print” section. 
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Section 8  

Establishing a connection 

8.1 Connecting the measuring receiver to AMA.remote  

In order to operate and monitor a measuring receiver remotely, you must have the SNMP interface 
activated in AMA 310. This can be done by obtaining a license for the use of the full range of 
functions of “AMA.remote.” More information is available from the manufacturer and in the operating 
manual of the measuring receiver. 
 
For remote control, monitoring or measurement data recording of a measuring receiver from a PC 
with the AMA.remote software, a connection first must be established between the measuring 
receiver and PC. It does not matter at this stage whether the PC and measuring receiver are 
connected to each other within a company network or whether each of them are connected to the 
Internet. The basic connection between the measuring receiver and PC is shown in the following 
figure. 

 

In order to connect the measuring receiver with a network, the measuring receiver is equipped with a 
standard 10Base-T Ethernet interface with a maximum transfer rate of 10 Mbit/s. The RJ-45 socket 
used for this purpose is located on the right side of the instrument. 
 
Depending on the existing network structure, various information and procedures are necessary for 
establishing a connection between the measuring receiver and the PC. Due the great variety of 
possibilities, the manufacturer cannot provide explicit instructions or information in this regard, but 
the important differences are briefly explained below. 
 
NOTE! The manufacturer cannot offer any support for establishing a network connection 

between the measuring receiver and PC. 
 
For setting up a connection between the measuring receiver and a PC, knowledge about the existing 
network or networks is absolutely necessary. For example, a free IP address that can be assigned to 
the measuring receiver must be available. 

8.2 Connecting AMA.remote with the network or Internet 

8.2.1 Connecting within a network 

One possible application for the remote control of a measuring receiver is within a network with PCs 
or servers and head ends. AMA.remote software runs on one or more PCs in this network. For 
example, measurements are to be taken at a head end, and a measuring receiver may be 
connected with the network via the head end for this purpose.  
 
It is possible that the network is divided into subnetworks and that it contains several gateways. For 
this reason, the subnet mask and the standard gateway can be entered in the measuring receiver in 
addition to the IP address. 
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8.2.2 Connecting via VPN 

In addition to the option to connect the measuring receiver and PC within the same network, it is 
also possible to connect the two over the Internet. The network in which the measuring receiver is 
located and the network in which the PC is located are each connected to the Internet through a 
router. The respective network may consist only of a modem with router function and the measuring 
receiver or PC.  
 
One possible application is remote control of a measuring receiver at a measuring point from a PC in 
a company network. 
 
In order to avoid unwanted access to a component from the Internet within a network, a variety of 
mechanisms exist (firewalls, for example). There are two ways to ensure that the AMA.remote 
software can nevertheless access a measuring receiver on a router via the Internet. 
 
One option is to set the firewalls and other parameters on the associated network components so 
that the connection is allowed and possible. For example, the ports for an SNMP connection (UDP 
ports 161 and 162) must be enabled. We do not provide further explanation for this option here. 
 
Another option consists of configuring a Virtual Private Network (VPN). With this option, the network 
components of another network appear to be part of your own private network. When establishing a 
VPN connection, a tunnel through the Internet is defined between two routers, and the transmitted 
data is encrypted. 

 

The software that establishes the VPN connection needs to know and use the globally valid IP 
addresses of the connection participant. This aspect is explained in more detail below. 
 
The measuring receiver itself is not VPN-capable. The router must take over this function on the 
connection side of the measuring instrument. It is usually sufficient to set up this router in this 
manner once using a PC. For operation of the measuring instrument on this router, a PC is no 
longer needed. 
 
On the PC with AMA.remote side, the operating system’s own VPN program can be used for 
establishing the connection, for example. The router to which the PC is connected needs to allow 
this VPN connection, however. In a company network, it may be necessary to contact the network 
administrator. 
 
There are also VPN-capable routers that support establishing a connection to another router of the 
same manufacturer. If the router to which the measuring receiver is connected and the router to 
which the PC is connected are from the same manufacturer, it may be possible to use a program 
from this router manufacturer to easily set up a VPN connection. 
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8.3 Connecting the measuring receiver with the network or Internet 

In order to establish a connection between two components via the Internet, both components must 
be uniquely addressable. Otherwise, it cannot be ensured that data can be exchanged between the 
two components. 
 
The IP address of a network component is usually only valid within what is referred to as the private 
network. The components of a network, including their IP addresses, are generally hidden from the 
Internet. If data is sent over the Internet, the router replaces the IP addresses of the sending network 
component with its own IP address. The IP address of the router is not reachable from the Internet, 
and when the router receives data from the Internet, it replaces its own IP address with the IP 
address of the network component that is to receive the data. 
 
You must ensure that a router is part of a network. Depending on the Internet provider, a router has 
what is known as a public or private IP address. A public IP address is globally unique. But there are 
also Internet providers that assign private IP addresses to their routers and convert these addresses 
for the Internet in an additional router. A VPN connection cannot usually be established to a router 
with a private IP address, since it is not uniquely addressable. An exception to this rule is a 
connection between VPN-capable routers of the same manufacturer. 
 
For connection via the Internet between a measuring receiver and a PC with AMA.remote software, 
knowledge of the respective router addressing is therefore absolutely necessary. In the following, 
the assumption is made that the PC with AMA.remote software has an Internet connection. As a 
mobile device, the measuring receiver can connect to the Internet via a VPN-capable router either 
using a mobile Internet connection or through a cable or DSL modem. 
 
The option that is most suitable depends on the actual situation. 

8.3.1 Mobile Internet connection 

A universal Internet connection is a connection through one of the mobile standards GSM, UMTS or 
LTE. The measuring receiver is connected to a VPN-capable router using an Ethernet cable. For 
example, for this router it is possible to connect to the Internet using a USB stick for mobile Internet 
(GSM, UMTS or LTE). This USB stick usually contains a SIM card from a suitable provider.  
 
The advantage of a mobile Internet connection is that an Internet connection that is set up once can 
be established from anywhere (assuming there is network coverage). Depending on the rate plan 
that is chosen, it may be necessary to explicitly start the mobile Internet connection when 
establishing the connection for the measuring receiver. Otherwise, it is not necessary to have a 
cable or DSL connection, for example, since data is transmitted wirelessly. 

 

8.3.2 Cable connection 

Another option for establishing the Internet connection for the measuring receiver consists of the use 
of a cable connection. The VPN-capable router to which the measuring receiver is connected is 
connected to a cable modem. 
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8.3.3 DSL connection 

Similar to the use of a cable connection, the Internet connection can be established using a DSL 
connection. The VPN-capable router to which the measuring receiver is connected is connected to a 
DSL modem. DSL routers are also available. These products combine a DSL modem and router into 
one unit, and such units can be used in the same way.  
 
If the VPN-capable router to which the measuring receiver is connected has integrated DSL 
functionality, it can be directly connected to the DSL connection. It may be the case that the DSL 
connection will be occupied during the period of remote control of the measuring receiver, blocking 
use of the Internet in a private household, for example. 

 

8.4 Summary of the procedure 

In order to control or monitor the measuring receiver remotely using the AMA.remote software, the 
measuring instrument must first be connected to the network using an Ethernet cable. A suitable IP 
address is then assigned in the measuring receiver, and it may be necessary to carry out additional 
configuration.  
 
If the measuring receiver and the PC with AMA.remote are located in the same network, the 
connection can be checked from the PC using a ping test of the IP address of the measuring 
instrument. If this test gives a positive result, the remote control, monitoring or long-term 
measurement data recording with the AMA.remote software can be started (more information is 
provided in “The remote control application area”, “The monitoring application area” or “The long-
term measurement data recording application area” section). 
 
If the measuring receiver and PC with AMA.remote are to be connected via the Internet, the 
measuring instrument must first be connected to a router, and an Internet connection must be 
established if one does not yet exist. The Internet connection cannot be established from the 
measuring receiver, but must instead be established from a PC. A VPN connection must then be 
established between the router with the measuring instrument and the PC with AMA.remote. This 
connection can also be checked with a ping test from the PC with AMA.remote. As soon as this 
connection is successfully established, remote control, monitoring or measurement data recording 
with AMA.remote software can also be started in this case. 
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Section 9  

The remote control application area 

9.1 Display 

If the “Remote control” tool is called up, the corresponding application area is displayed in the 
program window. As previously mentioned, this function can only be used after the SNMP interface 
is activated in AMA 310 (see section “Establishing a connection”). After a connection has been 
successfully established between the measuring receiver and PC with AMA.remote, the settings can 
be made and the parameters can be read on the measuring instrument.  
 
The display in the top area of the window is similar to the one on the LCD of the measuring 
instrument. Parameters are also displayed here that are not displayed on the measuring instrument 
until submenus are activated. The central area of the program window contains control elements for 
entering the desired settings. A list of IP addresses of measuring receivers to which a connection 
exists appears in the bottom area. 

 

9.2 General procedure 

9.2.1 Connecting to a measuring receiver 

Once the user has started AMA.remote in administrator mode (see section “Start program”), clicking 
on “Search for AMA” triggers the search for measuring instruments in the network. All IP addresses 
that are already in the list are deleted in the process, so a prompt appears. The prompt asks 
whether the list should really be updated and whether all agents, i.e. measuring receivers, should be 
deleted along with their properties. Click “Yes” to start the search. 
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A message appears in the status bar that a search is being carried out for measuring receivers. 

 

As soon as the search is complete, all IP addresses of the measuring receivers in the network 
appear in the corresponding list. 

 

If no measuring receiver can be found in the network, a corresponding message appears. 

 

In many cases, the search is successful after a second search. It is also possible to select “Add 
AMA” from the menu bar. This inserts a measuring receiver directly into the list of agents (see the 
“Add AMA” section for more information). If the search for measuring receivers in the network is 
unsuccessful several times, it may make sense to change the transmission settings (see the 
“Transmission settings” section for more information). 
 
Clicking the IP addresses of the measuring receiver that is to be remotely controlled causes the data 
to be retrieved. The parameters that are currently set on the measuring instrument and its measured 
values are retrieved. 

 

Furthermore, the system also determines if a user is already accessing the measuring instrument. If 
this is the case, and you’re not using a standard login name, then you cannot change the measuring 
receiver settings. However, you can query measured values and parameters. You can only get full 
access to the measuring instrument once the other user has logged out. 
 
When all data has been retrieved, the message “Done” appears in the status bar and the received 
values appear in the top area of the program window. If the connection fails, more information can 
be found in the “Connection problems” section. 
 
Each time one of the IP addresses is clicked, data retrieval is triggered. Double-clicking an IP 
address opens a window for this agent’s settings for sending and receiving data. These are settings 
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that are also made when manually adding a measuring receiver. You can find more information in 
the “Add AMA” section. In administrator mode, you can also remove the measuring receiver from the 
list of measuring instruments in the network by pressing the “Delete” key on your PC keyboard. This 
information is also available as a short info text, which is displayed when the you move the mouse 
pointer over the list of IP addresses. 

 

9.2.2 Tuning the measuring receiver 

In order to carry out a measurement, the measuring receiver is tuned to a channel or frequency. 
The measuring instrument is tuned using control elements in the centre of the program window. 

 

The settings are made from left to right starting with “Range”. The number and type of the displayed 
control elements are adjusted according to the previous setting. After a setting has been made, the 
corresponding command is immediately sent to the measuring receiver. The control elements are 
deactivated until the measuring instrument has carried out the command. The currently applicable 
measured values and parameters are then retrieved by the measuring instrument, but it is not 
necessary to wait for this data to be received.  
 
The entry of settings continues until the desired information appears on the screen. As soon as data 
retrieval is complete, the message “Done” appears in the status bar. 

9.2.3 The HOME key 

There is a control element for the remote control that corresponds to the “HOME” key on the 
measuring receiver. This control element resets the measuring receiver to the default status of the 
respective measuring range. 

9.2.4 Recalling a tuning memory location 

The fastest option for tuning a measuring receiver consists of calling up a tuning memory location. 
This is done by entering the desired memory location number directly into the text field provided for 
this purpose and completing the entry with the “Enter” or “Return” key. 

 

This procedure corresponds to the entry of a tuning memory location using the numeric keypad on 
the measuring receiver after the “RECALL” key has been pressed on the measuring instrument. The 
number of the memory location that has been called up appears as it is shown on the LCD of the 
measuring receiver on the top left. 
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9.2.5 Mode oft the measuring receiver 

You can set the measuring receiver mode to normal measurement (Measure), Analyzer, 
constellation diagram (Const) and scope display (Scope).  

 

 
This is useful, for example, when the measuring receiver is connected to a transponder at the 
SCART connection and the output video signal is fed into a free channel. When AMA.remote is 
being used and you want to allow the user to access this channel, the user can view the analyzer 
display, constellation diagram display or scope display in real time as if they were standing at the 
measuring receiver. 
 
You should only switch to the constellation diagram display when the instrument is tuned to a digital 
channel or a modulated return channel. Similarly, you should only switch to the scope display when 
tuned to an analog channel. 

9.2.6 Automatic refreshing of the values 

In order to avoid having to manually retrieve the data again and again, there is an automatic data 
retrieval option. The hours, minutes and seconds of the interval after which the values are to be 
refreshed are specified for this. 

 

Due to the length of time needed for data transmission and time that the measuring receiver needs 
to carry out the commands, a short amount of time does not make sense. The possible lower 
tolerance level for a refresh time varies according to the measuring range and the transmission 
distance. The minimal possible time can be quickly determined using tests with different values, 
however. 
 
Automatic refreshing of the values can be stopped by setting the values for hours, minutes and 
seconds to zero.  

 

9.2.7 Refreshing the values manually 

“Refresh values” can be activated to refresh the displayed values once. The values are current when 
“Done” appears in the status bar. 
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9.2.8 Connection problems 

When the measuring receiver does not respond to a sent command, AMA.remote automatically 
repeats the command several times. If the measuring instrument does not respond within an 
appropriate period of time, the assumption is made that there is a connection problem, and a 
corresponding message appears. 

 

After confirmation of this message, manual data retrieval can be started in order to determine 
whether the connection is experiencing a non-transient failure. If the connection problems only occur 
sporadically, it may make sense to change the transmission settings (see the “Transmission 
settings” and “Add AMA” sections for more information).  
If a connection problem occurs during tuning of the measuring receiver, activation of the “HOME” 
command can be helpful. This resets the measuring instrument to a defined status, and tuning can 
begin again.  
 
There are a variety of causes of connection problems. If the measuring instrument switches off or 
the Ethernet cable is disconnected, it is not possible to establish a connection to the measuring 
instrument, of course. A high volume of network traffic can also lead to delays in data transmission 
or to loss of data packets. A change in the transmission settings can also be helpful here. 
 
For a connection via the Internet between a measuring receiver and a PC with AMA.remote, a check 
must be done for whether an Internet or VPN connection still exists. Many Internet providers change 
the IP addresses in their networks periodically. This can cause an existing connection to be 
interrupted. 
 
In order to exclude the possibility that a network problem exists, it can make sense to run a ping test 
to the IP address of the measuring receiver. If network problems can be excluded, it might be that 
too many commands at once led to delayed processing. It can helpful in this case to wait several 
minutes before starting data retrieval again. Since the measuring receiver processes the commands 
as they were received, it can take an unusually long time until the measuring instrument executes 
the last command if the connection is bad. 

9.3 File 

The “File” dropdown menu is located on the far left of the menu bar. 

 

9.3.1 Save 

The “Save” menu item saves the current parameters and measured values along with a time stamp 
in an XML file. If no file has been specified, the “Save as” window opens; otherwise the current data 
is attached to the data in the file that was most recently used. The name of the current file is shown 
in the status bar. 

 

The XML file can be opened and edited with a spreadsheet program that supports editing of XML 
files. 
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9.3.2 Save as 

As with “Save,” the “Save As...” menu item saves the current parameters and measured values 
along with a time stamp in an XML file. When this menu item is selected, the “Save as” window 
opens. The save location is selected here and a file name is assigned. You complete the process by 
clicking “Save”.  

9.3.3 Importing a file 

The “Import” menu item activates the “Open” window and allows you to import individual files or 
several files. No files can be imported for the remote control. Importing a file activates one of the 
other application areas. Accordingly, tuning memory files, channel table files and DataLogger files 
are available. 

 

For more information, see the sections for the corresponding application areas. 

9.3.4 Settings 

You can activate the “Settings” drop-down menu from the menu bar. The drop-down menu looks 
different depending on the login mode. In administrator mode (see section “Start program”), you 
have options for editing the transmission settings, administrator settings and user settings, and to 
load the user channel table. In user mode, you can only load the user channel table. 

 

9.3.5 Transmission settings 

All settings for data transmission can be made under the Transmission settings item. 
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The settings apply to all connections between AMA.remote and measuring receivers while the 
program is running. 
 
The AMA Discovery Timeout is the length of time for the search for measuring instruments in the 
network. The standard value is 2 seconds (2,000 milliseconds). If a measuring instrument in the 
network is often found shortly before this timeout or not until the second attempt, it can make sense 
to increase this value after the program is started and before a search is run. This causes 
AMA.remote to wait longer for responses from the network. 
 
Answer Timeout refers to the time that AMA.remote waits for a response from the measuring 
receiver after sending a command. After this period elapses, an error message is generated. This 
error message is not displayed until it occurs several times, since it is generated for every command 
for which no response is received. It can be the case that the command was already repeated and 
responded to. The standard value is 20 seconds (20,000 milliseconds). It can make sense to 
increase this time if there is heavy network traffic. 
 
Before the Answer Timeout has elapsed, AMA.remote repeats the request. The standard value is 15 
seconds. This time should be less than the Answer Timeout. 

9.3.6 Add AMA 

A measuring receiver can be manually entered into the list of SNMP agents of type AMA via “Add 
AMA”. The setting options correspond to those shown when an IP address in the list is double-
clicked. 

 

The AMA IP address is the address that is entered in the measuring receiver. Furthermore, you can 
enter a name or place for the measuring receiver in order to make it easier to assign an instrument 
to an IP address. 
 
The answer timeout corresponds to the setting in the transmission parameters, but is used explicitly 
for the entered IP address here. The same applies for the time after which a request is repeated. 
 
The commands for requesting the measured values and parameters from a measuring receiver are 
sent in small packets by default. It may be advantageous to request each value individually. This 
setting can be made by placing a tick next to “Send individual Get requests for each variable”. 

9.3.7 Edit administrator settings 

You can change the administrator login data at any time by entering the current password. You can 
create a new login name and a new password. 
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When you try to connect with a measuring receiver, the system queries whether an administrator or 
user is already accessing the instrument. If that is not the case, the login name is transmitted to the 
instrument. From that moment on, this login name can be read by other PCs in order to see who is 
currently accessing the instrument. That’s why it makes sense to use the name of a person as the 
login name, in order to make it easier for other administrators and users to identify who has access 
to the instrument.  
 
There is only one administrator login for an AMA.remote installation.  
 
The password is encrypted and saved on the PC. If you forget your login name or password, contact 
the manufacturer’s service department (see section “Contacting the manufacturer”). 

9.3.8 Edit user settings 

You can create multiple users for an AMA.remote installation. 
 

 
 

All of the users that have been created are listed under “Existing Users”. 
 
You can click “Add user” to create a new user. As with the administration settings, when you try to 
connect with a measuring receiver, the system queries whether an administrator or user is already 
accessing the instrument. If that is not the case, the login name is transmitted to the instrument. 
From that moment on, this login name can be read by other PCs in order to see who is currently 
accessing the instrument. That’s why it makes sense to use the name of a person as the login 
name, in order to make it easier for other administrators and users to identify who has access to the 
instrument. 
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You can change the password for an existing user by clicking “Edit user”. This allows you to 
overwrite login data that have been lost or forgotten. 
 

 
 

You can delete a user from the list by clicking “Delete user”. After you confirm the query, if you really 
want to delete the user, the login data for the selected user are deleted. 

9.3.9 Loading a user channel table 

Channel tables for the various television standards are stored in the measuring receiver, and this 
corresponds to the standard setting. It is possible to load a user channel table, the use of which is 
taken into account when selecting a channel. In order to create the same conditions as on the 
measuring receiver, the user channel table that is used in the measuring receiver can also be loaded 
into AMA.remote.  

 

The file name of the currently loaded user table appears in the status bar on the bottom edge of the 
AMA.remote window. 

 

During the entry of the settings for tuning of the measuring receiver, the selection “standard” 
appears for the stored channel tables, and the selection “user” appears for the currently loaded user 
channel table. When no user channel table is loaded, only “standard” appears as an option. 
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Section 10  

The monitoring application area 

10.1 Display 

When the “Monitoring” tool is opened, the associated application area is displayed in the program 
window. As previously mentioned, this function can only be used after the SNMP interface is 
activated in AMA 310 (see section “Establishing a connection”). After a connection has been 
established between the measuring receiver and PC using AMA.remote, the measured values of a 
tuned channel or of a tuned frequency can be monitored. 
 
The upper part of the “Settings” view shows whether tuning was done through the tuning memory or 
remote control tool. A small table displays the main parameters of the channel to which the device 
was tuned. In the middle section, you can enter the settings for the lower and upper limits of the 
measured values to be monitored. In addition, there are settings for specifying whether monitoring 
should occur only for a certain period of time and, with digital channels, whether the state 
(locked/unlocked) and packet errors should be monitored. 

 

The “Log” view of the “Monitoring” tool shows, in a table, the data that was exchanged between the 
AMA.remote and measuring instrument. After monitoring starts, the measuring receiver is configured 
and, if the instrument triggers a trap message, a corresponding message appears. In addition, the 
start time, all trap messages and the stop time are always saved automatically in a log file (see 
section “Save As”). 
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10.2 General procedure 

Before a channel can be monitored by the measuring receiver, the instrument must be tuned to the 
corresponding frequency. To do this, you can either select a row from a tuning memory table or use 
the “Remote control” tool.  
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If the instrument has not yet been tuned, you can use one of the “Open” interfaces to select the 
corresponding tool. Also, either one of the tools can be activated in the “Tools” menu item. 

10.2.1 Tuning using a tuning memory location 

When you select a row in the tuning memory list and then switch to the monitoring view, the 
instrument is automatically tuned according to the information. 

 

It may happen that a tuning memory assignment other than the one selected in AMA.remote is 
loaded in the measuring receiver. To ensure that tuning is always successful, the parameters of the 
marked row are sent to the measuring instrument according to their order. The tuning memory table 
is greyed out during this time, and the view does not switch to “Monitoring” until after tuning has 
taken place. 

 

In the small table displayed, you can check whether tuning was successful based on the main 
parameters to which the measuring receiver was tuned. 
 
NOTE! If the tuning memory assignment that is loaded in the instrument is known, tuning 

takes place quicker when you enter the number of the desired tuning memory 
location next to “Recall:” in the “Remote control” tool directly. 

 
Tuning from the “Tuning memory” tool, then switching to the “Monitoring” view, also works without 
having to start in the “Monitoring” view. For example, after the program starts and the connection 
with a measuring receiver has been established, you can go directly to the “Tuning memory” 
application area, select a row and switch to “Monitoring.” 

10.2.2 Tuning through remote control 

After the measuring receiver has been tuned successfully in the “Remote control” application area, 
you can switch to the “Monitoring” view. 
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Data retrieval from the measuring receiver must be complete before the “Monitoring” tool can be 
activated (“Done” will appear in the status bar). 

 

Even in this case, the small table shows the main parameters. 

10.2.3 Values to be monitored 

Depending on the monitoring program of the instrument (see the operating manual of the measuring 
receiver), various measured values can be monitored according to the measuring range.  
 

Range Operating 
mode 

Monitored parameters 

SAT   

 ATV Level, S/N (only with S/N option) 

 DVB-S Level, MER, CBER, VBER, PE 

 DVB-S2 Level, MER, CBER, LBER, PE 

TV   

 ATV Level, S/N (only with S/N option) 

 DVB-C Level, MER, BER, PE 

 DVB-T Level, MER, CBER, VBER, PE 

 Euro-
DOCSIS 

Level, MER, BER, PE 

 US-
DOCSIS 

Level, MER, VBER, PE 

FM  Level 

RC  Level, MER, BER 

DAB  Level, MER, CBER 

 
In addition, the state (locked and unlocked) can be monitored when digital channels are used. 
 
Depending on tuning, possible entries for the relevant measured value are displayed. 
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A measured value is included in monitoring when a limit is specified. If the upper limit is exceeded, 
or the lower limit is not reached, the measuring instrument sends an “Alarm” message. As soon as 
the measured value is again within the limits, an “OK” message is sent. 
 
Limit values can be entered as an absolute value or a difference value. When an absolute value is 
entered, the upper limit or lower limit is entered with a specific value.  
 
A difference value can be entered by activating the checkbox under “Diff.” at the level of the 
corresponding measured value. The possible value entries correspond to the tolerance 
specifications of the instrument’s monitoring program (see the operating manual of the measuring 
receiver). 
 

Parameter  Difference value 

Level 0.1 dB – 9.9 dB 

MER 0.1 dB – 9.9 dB 

S/N 0.1 dB – 9.9 dB 

BER e+1 – e+3 

 
Entering, for example, 1 dB as the lower limit for the level, MER or S/N means that the measuring 
instrument sends a message if the measured value is more than 1 dB lower than the lower limit. The 
difference is taken from the last measured value that was transmitted before switching to the 
“Monitoring” view. 
 
If the instrument, for example, was just in the unlocked state because of a very poor signal, no 
reference values are present. Next, an error message will appear, asking you to enter an absolute 
value. 

 

The difference value for BER also applies to BER, CBER, VBER and LBER. When “e+1” is entered 
as the upper limit, it means that the bit error rate can be increased by a factor of 10 without 
triggering the alarm. The “e” stands for exponent, and it is the same as entering “1*10^1” (for 1*101) 
or “1x10^1” (for 1x101). 
 
There are no limit value specifications for packet errors (PE). If the packet error counter is to be 
included in the monitoring, the “Monitor PE” checkbox must be activated.  

 

An “Alarm” message is sent to AMA.remote as soon as at least one packet error occurs. If an error 
is permanent, another error message is sent after 60 seconds. This means that, when packet errors 
occur continuously, the current state is transmitted every minute (see also the operating manual of 
the measuring receiver). An “OK” message is not sent during packet error monitoring as it is not 
possible to reach the limits when no limit is entered. 
 
The state of the measuring receiver is monitored when the checkbox next to “Monitor state 
(locked/unlocked)” is selected.  
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If the state changes from “locked” to “unlocked” or vice versa, a “State” message is sent with the 
information on the current state. 

10.2.4 Entering the duration of monitoring 

You can enter the duration of monitoring. After the specified time has expired, the monitoring 
information is cleared in the measuring instrument and monitoring ends. 

 

The information on the duration of monitoring can be reset by setting the value for hour and minute 
back to nil. 

 

Monitoring can also be started without entering a duration period and stopped again after any 
amount of time. 

10.2.5 Starting monitoring 

After all information required for monitoring has been entered, the process is activated by clicking 
“Start”. 

 

First, the actual SNMP Manger of AMA.remote is started. The three pieces of information required 
are the IP address of the PC on which AMA.remote is running, the SNMP trap port and the engine 
ID. Usually, you can leave the suggested values and click “OK.” More information on the SNMP-
specific information can be found in document “AN001 SNMP Remote Control Application Note.” 

 

The screen switches to the “Log” view, and the data that was exchanged between the AMA.remote 
and measuring instrument is shown in edited form in a table. As previously mentioned, this data is 
also automatically saved in a log file together with the start and stop time (see section “Save As”). 

10.2.6 The log table 

First, the measuring receiver is configured for monitoring. A time stamp and the IP address of the 
instrument are displayed for every message received by the instrument. The message type is “set” 
during configuration as the corresponding values in the measuring receiver are being set. The index 
corresponds to the row in one of the three SNMP trap tables (amaEventTable, amaTrapTable and 
amaAlarmTable) in which the configuration data are stored in the instrument. As Event Owner, you 
can see the IP address of the PC, which means this is the address to which the measuring 
instrument sends the messages. The “State” parameter is treated as a trap variable; all other 
measured values that should be monitored are treated as alarm variables. Configuration was 
successful when “configured” is displayed as the state. The SNMP-specific details will not be 
discussed further at this point. Detailed information regarding the configuration of the measuring 
receiver via SNMP for monitoring and, in particular, the SNMP trap tables can be found in the 
document “AN001 SNMP Remote Control Application Note.” 
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“Clear table” can be used to clear the displayed table content. The contents of the log file (see 
section “Save as”) is not affected. Primarily, only SNMP messages are saved in the log file. As this 
information can be too detailed in some instances, “Save table” gives you the option to save the 
displayed table as an XML file. An XML file can be opened and edited with a spreadsheet program 
that supports editing of XML files. 

 

As previously mentioned in the “Values to be monitored” section, a “State” message can be sent by 
the measuring receiver if the state changes from locked to unlocked or vice versa. “State” is then 
displayed as the message type in the log table. In addition, “State” is also the monitored measuring 
parameter, and this name is also displayed. Finally, the current state (UNLK or LOCK) is sent with a 
“State” message and entered into the log table.  

 

If a specified limit is exceeded or has not been reached, an “Alarm” message is sent. Along with this 
message type, the name of the measured value to be monitored (e.g., “Level”), the current value 
and the lower and/or upper limit, depending on specifications, are displayed. As soon as the 



  Section 10 - The monitoring application area 

  AMA.remote V00.05 

49 

measured value is again within the specified limits, an “OK” message appears and reports the 
current value. 
 
“Stop” can be used to end monitoring. All entries in the SNMP trap tables of the measuring receiver 
that were made during configuration are cleared at this time. 

 

For example, in the event that the PC crashed while monitoring with AMA.remote was running and, 
therefore, the configuration of the instrument could not be reset properly, there is a “Reset AMA” 
button. This button clears all entries in the SNMP trap tables of a measuring receiver, even those 
that may have been made by another SNMP management program. For this reason, a prompt 
appears asking you if you really want to proceed before AMA is reset. 

 

10.3 File 

The “File” dropdown menu is located on the far left of the menu bar. 

 

10.3.1 Save as 

If no memory location for the log file was specified before monitoring started, the file is automatically 
stored in the installation path for AMA.remote. For example, this path could be “C:\Program 
Files\AMAremote\”. If you want to store the log file in another directory, enter the path in the “Save 
As...” menu item. 
 
The file is automatically named “trapyyyymmdd.log”, where “yyyy” stands for year, “mm” for month 
and “dd” for day. However, this proposed file name can be changed. The “log” file extension signifies 
the log file, which is a common text file that can be opened using a text editor. 
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The file name under which the log data is being saved is shown in the status bar. 

 

10.4 Settings 

The “Settings” dropdown menu can be activated using the menu bar. Setting options for data 
transmission are summarized here. 

 

The submenu items correspond to those in the “Remote control” view; refer to the “Settings” 
subsection in “The remote control application area” section. 
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Section 11  

The long-term measurement data recording application area 

11.1 Display 

Calling up the “long-term measurement” data recording tool displays the corresponding application 
area in the program window. As previously mentioned, this function can only be used after the 
SNMP interface has been activated in AMA 310 (see section “Establishing a connection”). Once a 
connection between the measuring receiver and PC has been established using AMA.remote, up to 
five channels or frequencies can be monitored. 
 
Under “Recall” in the “Settings” view, the tuning memory location can be specified for each one of up 
to five measurements. The contents of the tuning memory location can be checked using “Check”, 
since the corresponding memory location is called up for the measuring receiver. A small table 
below for monitoring displays the main parameters of the channel to which the device has been 
tuned. The measuring interval and, if desired, the duration of the measurement(s) can also be set in 
this view. 

 

The measured values are displayed as graphs in the remaining tabs. During measurement, the 
measured values are saved as CSV files, whose names appear on the tabs. The main parameters 
of the measurement can be seen in a small table in each view. The respective measured values are 
displayed in diagrams.  
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Another program window is opened if you click on “Details” to the left of a diagram. This window is 
for evaluating a set of measurements. A limit can be entered, and the measured values up to that 
limit will be analysed. In addition to other information in this view, a table with the selected data is 
displayed at the bottom of the window.  
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11.2 General procedure 

In order to carry out a long-term measurement data recording, the tuning memory assignment for the 
measurement receiver must be known. The memory assignment can be exported from the 
measuring receiver with a USB stick and imported using AMA.remote (see the section on “Importing 
a tuning memory file”). Suitable memory locations can be defined for a measurement data recording 
in the “Tuning memory” program view. 
 
Before one or more channels can be monitored or measurement data can be recorded, the desired 
tuning memory location must be specified and checked.  

 

If the specification of the tuning memory location is not verified when “Check” is activated, an error 
message appears at the start of the measurement. 

 

The control elements are deactivated while the measuring instrument is being tuned. The measuring 
receiver has been successfully tuned when “Done” appears in the status bar. The information in the 
table is then up to date. 

 

The check on the specified tuning memory location may show as being successful if a different 
tuning memory assignment to what the user is expecting is loaded in the measuring receiver. Use 
the display of the main parameters in the table to check whether these are the desired parameters.  
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In rare cases, the measuring instrument cannot call up the tuning memory location correctly due to a 
transmission error, for example. The memory location number must be entered a second time and 
“Check” must be activated again. During the measurement, the parameters shown here are 
compared with the values received and are retrieved again automatically if there is a discrepancy. 
This is why it is important that the measuring parameters in the table are checked for correctness. 

11.2.1 Measurements for one channel 

If just one channel is to be monitored, the measuring instrument is tuned once at the start time and 
just the measured values are called up at each interval in the following. This saves time compared to 
measurements with several channels that have to be switched between. The minimum possible 
interval here is therefore 5 seconds. 

 

Furthermore, if long-term measurement data is being recorded from one channel, this channel can 
be monitored with the “Monitor” tool in parallel (see the “Monitoring application area” section). We 
recommend that you configure the measuring instrument for monitoring first and then start the 
measurement data recording. Since the channel in the measuring instrument is not changed, it 
continues to be monitored. Any value that exceeds the limit is displayed during monitoring, while in 
the background the measured values are recorded at the given interval. In this way, both gradual 
trends and infrequent disturbances can be monitored. 

11.2.2 Measurements for two to five channels 

For measured value recordings from several channels, the measuring receiver is tuned before each 
measurement, and the measured values are then retrieved. This can take several seconds, 
especially for digital channels. Therefore, the minimal possible interval here is 30 seconds; 
measuring five digital channels can take around one minute. 

 

11.2.3 Entering the duration of a long-term measurement data recording 

You can enter the duration of a measurement data recording. The recording will end automatically 
after the time given. 

 

The settings for the duration of the recording can be reset by setting the value for days and hours 
back to nil. Measurement data recording can also be started without entering a duration period and 
stopped again with “Stop” after any amount of time. 

11.2.4 Memory requirement 

Around 50 bytes are required for a digital measurement with values for the level, MER, CBER, 
VBER and PE, for example. There must be enough memory available for the measurement data, 
which depends on the number of measurements, derived from the specifications for the interval and 
duration. 
 
As already mentioned, the measured values are saved in CSV files during measurement. This data 
format was chosen because the files can then be opened with standard spreadsheet programs as 
well. However, the number of rows cannot exceed 65536. For this reason, a message appears 
requesting to begin a new measurement if the number of rows exceeds 65000. This gives enough 
time to end one measurement and start another with a different file name. This guarantees that the 
files can be read by other programs. 
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11.2.5 Starting a measurement 

After entering the tuning memory location to be used, the measurement interval and, if necessary, 
the duration, the measurement is started by clicking “Start”. 

 

If no location for storing the measurement file(s) has been given with the menu item “Save as...” 
(see “Save as” section), a message will appear and the “Save as” window will be opened.  

 

Once the file path is known, the long-term measurement data recording is started. After receiving the 
measured values for a channel, the view switches to the corresponding diagrams. 

11.2.6 The measured data 

Various measured values are retrieved depending on the measuring range. 
 

Range Operating 
mode 

Measurable parameters 

SAT   

 ATV Level, S/N (only with S/N option) 

 DVB-S Level, MER, CBER, VBER, PE 

 DVB-S2 Level, MER, CBER, LBER, PE 

TV   

 ATV Level, S/N (only with S/N option) 

 DVB-C Level, MER, BER, PE 

 DVB-T Level, MER, CBER, VBER, PE 

 EU-DOCSIS Level, MER, BER, PE 

 US-DOCSIS Level, MER, VBER, PE 

FM  Level 

RC  Level, MER, BER 

EMI  Field strength (FS) 

DAB  Level, MER, CBER 

 
The main measuring parameters and the last received status of the measurement (locked or 
unlocked) are shown in a single-row table. The measurement data is displayed in diagrams. To the 
left of each diagram, the measured value type and the last received value are each shown in a text 
field. By clicking on the diagram, a cursor, represented by a red line, is placed on the closest data 
point. The measurement time and the measured value of the selected data point are displayed 
above the cursor. 



56 Section 11 - The long-term measurement data recording application area 

AMA.remote V00.05 

 

The section of the diagram displayed can be zoomed in on horizontally and vertically by moving the 
mouse with the left mouse-button held down. You can zoom out of the section again by clicking on 
the minus sign next to the scroll bar for scrolling along the section. 

 

Once a new measured value is added, the section of the diagram will be moved to the right 
automatically. This allows the last of many measured values to be monitored in detail during 
measurement. 

11.2.7 Details of one measured value type 

Another program window is opened if you click on “Details” to the left of a diagram. The main 
measuring parameters are shown here, too, in a single-row table. Furthermore, the first and last 
times in this measurement and the total number of measured values are given. 

 

In this case too, the measured data is displayed in a diagram, and clicking on the diagram places a 
cursor on the closest data point. The section of the diagram displayed can also be zoomed in on 
horizontally and vertically.  
 
Furthermore, a limit can be entered underneath the diagram. A red, horizontal line appears in the 
diagram after confirming by pressing the “Enter” or “Return” key. This line is also displayed in the 
diagram of the measured value type in the main window. The limit entered is also saved in the 
measured data recording file and is displayed again when the file is opened. Deleting the limit 
removes the red line. 
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A selection can be made in the area below the field for the limit value for evaluating the measured 
values. The number of measured values for which the selection applies is given in a text field. The 
corresponding measured values and their respective measurement times are listed in the table 
below this area. 

 

Similarly to the menu item in the main window, it is also possible to print from the window for 
evaluating the measured values (see the “Print” section).  

 

The entire contents of the table, depending on the selection made, will be printed out. If you want to 
print out only some of the rows of the table, the number of pages to be printed can be entered in the 
“Print” window. 
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The evaluation can be stopped by closing the window and can be carried out as often as needed, 
even during a measurement. However, during measurement, only data at the time the detailed view 
was opened will be included. New measured values will nevertheless continue to be handled in the 
main window. 

11.3 File 

The “File” dropdown menu is located on the far left of the menu bar. 

 

11.3.1 Open 

The “Open” menu item activates the “Open” window. Up to five long-term measurement data 
recording files can be opened simultaneously. A recording file has the file extension “.csv”. In order 
to open several files at once, select the files in the “Open” window by pressing the control or shift 
key and clicking the desired file names. 
 
In the same way as during a measurement, each filename is displayed on its respective tab. The 
files from a measurement always have the same name and each has the ending “_mx”, whereby the 
“x” stands for the number of the measurement, from one to five. 

11.3.2 Save as 

Clicking “Save as...” opens this window. The location and a filename can be entered here. The 
filename given is shown in the status bar. 
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The suffix “_mx” is automatically added to the given filename for each measurement, where “x” 
stands for the number of the measurement. As already mentioned, the full filename for each 
measurement is displayed on its respective tab. 

 

When needed, a recording file can be opened with a spreadsheet program. It may be necessary to 
specify “semicolon” as the separator when opening the file. The measuring parameters, measured 
value types and, if specified, limit values are displayed along with other data in the file header. The 
measured values and measurement times follow beneath. State “1” means “locked” and “0” means 
“unlocked”. 

 

11.4 Settings 

The “Settings” dropdown menu can be activated using the menu bar. Setting options for data 
transmission are summarized here. 

 

The submenu items correspond to those in the “Remote control” view; refer to the “Settings” 
subsection in “The remote control application area” section. 
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